
What’s New in DataCAD 15? 

Sun Shader 2.0 

Sun Shader 2.0 features a new rendering engine that has been optimized for speed of 
display, enabling you to review complex models with ease.  It has support for smooth and 
transparent materials, and features new toolbars to improve navigation.  Features such as 
GoTo Views and a Layer Manager enable better control over your model using familiar 
commands from DataCAD.  Sun Shader 2.0 is accessed via the “Sun Shader” option in the 
“View” pull-down menu, or the Sun Shader button on either the “Rendering” or “Viewer” 
toolbar. 

 

Transparency 

Sun Shader 2.0 has support for transparent materials, such as glass. When you assign a 
transparent material to an object, Sun Shader 2.0 will display it as transparent, enabling you 
to see through it.  Shadow Study mode also supports transparency, so you can see the effect 
of sunlight through windows. 

 



GoTo Views 

The GoTo View toolbar in Sun Shader 2.0 enables you to save view parameters, including 
rotation angle and zoom level.  Click the “Add View” button to add the current view to the 
list, click on “Update View” to update the selected view with the current view parameters, 
or click on “Delete View” to delete the selected view from the list.  Click the drop-down 
view menu to select a saved view from the list and display it on the screen. 

 

Layer Manager 

Click the Layer Manager toolbar button to open the Sun Shader Layer Manager.  It provides 
access to the layers that were turned on in your model when you launched the Sun Shader 
from DataCAD.  Use it to turn layers in the model on and off without having to close the 
Sun Shader and return to DataCAD, making it easier to explore construction options and see 
their effect on the Sun path and shadows. 

The Layer Manager contains familiar commands, such as All On, Set Active and Active 
Only.  In addition, options for Select All, Deselect All, and Invert Selection are available. 

 



Edge Properties 

There is an Edge Properties drop-down toolbar button which contains options for defining 
the properties of edges in your model.  It includes options to use the entity color or a specific 
color, and the ability to define the width (in pixels) that each edge should be displayed. 

 

Smoothing 

Sun Shader 2.0 has support for smoothing in material properties. When enabled, curved 
edges will not display facets, and will instead appear as smooth curves. 

 

Other toolbars 

Other toolbars, added for convenience, include the Zoom Toolbar, the Rotate Toolbar and 
the Review Toolbar.  From left to right, the Zoom Toolbar has buttons for zoom extents and 
zoom window.  The Rotation toolbar has buttons that rotate the model counter-clockwise 
about the Z axis, clockwise about the Z axis, counter-clockwise about the X axis or clockwise 
about the X axis.  When Shadow Study mode is off, you may use the Review Toolbar to 
check face winding, draw face normals, draw vertex normals, and also to show the positive 
(outside) face, the negative (inside) face, or both. 

 

Shadow Study Results 

Shadow study results, including location, date and time, and Sun position, are now 
displayed as text in the upper left of the Sun Shader viewing window when Shadow Study 
mode is enabled. 



Pan/Zoom/Rotate Widget 

The Pan/Zoom/Rotate widget is available in the "View" pull-down menu. When checked, it 
is displayed in the lower right corner of the Sun Shader 2.0 interface.   

Clicking the left and right arrows rotates the model about the Z axis, while clicking the up 
and down arrows rotates the model about the X axis.  Pressing and holding the [Shift] key 
while clicking the arrows will pan in the selected direction.  Clicking the center circle 
restores the model to the initial view.  Clicking the middle circle and then dragging the 
cursor clockwise about the center point zooms in on the model, while dragging counter-
clockwise zooms out. 

 



New Commands and Functions 

AutoCAD compatibility 

An option labeled “Flatten all entities to zero” has been added to the “Enter filename to 
export” dialog when exporting a file to DXF or DWG format for use in AutoCAD.  When 
checked, DataCAD will automatically change the Z-Base and Z-Height of all entities in the 
resultant DXF or DWG file to zero, placing them flat on the ground plane. 

 

XREF changes 

The option to ignore the drawing-level Clip Cube has been added to the [Ctrl]+[Right-click] 
context menu for XREF entities.  It is remembered on a per-XREF basis, and is off by default.  
If you check this option, the XREF will ignore the drawing-level Clip Cube and display the 
entire XREF outside of the Clip Cube.  When un-checked, only portions of the XREF that lie 
inside the drawing-level Clip Cube will be displayed; any portion of the XREF which is 
outside the clipping boundary will be suppressed from the view. 

Note: XREFs that have an XClip active will ignore the drawing-level Clip Cube. 



The toggle "Remember Layer Settings for GoTo Views" has been removed from the 
"Reference File Management..." menu in the "Insert" pull-down.  It has been renamed "GTV 
Link," and can be found in the Reference File Manager, the XREF Properties dialog, and the 
[Ctrl]+[Right-click] context menu for XREFs. This setting is remembered on a per-XREF 
basis. 

Note: Even if this option is off, the GTV links are still remembered for the XREF.  However, the 
XREF's layers will not be toggled on and off in response to changing GTVs unless this option is 
subsequently toggled on. 

 

The GTV Link feature now supports per-XREF highlighting in addition to the per-XREF-
layer highlighting that was previously supported.  Using this feature, you can insert an 
XREF and assign highlight color, line type and line spacing, and then save a GoTo View in 
the host drawing.  You can then assign different (or no) highlight color, line type and 
spacing, save another GoTo View in the host drawing, and DataCAD will remember these 
settings when switching between GoTo Views. 

If the "GTV Link" in the Reference File Manager is set to "On," the status of the "Ignore Clip 
Cube" setting is remembered with the host-level GoTo Views in the drawing. 

When an XREF is inserted with an enlargement factor, that same enlargement factor is now 
applied to the overshoot value for any objects in the XREF that have overshoot assigned by 
entity.  Previously, no enlargement factor was assigned to overshoot. 



Smart Arrow changes 

The "Current Color" toggle in the Text/Arrow/Smart Arrows/Color menu will draw the 
arrow heads using the current layer color.  Using this setting saves you the step of defining a 
color for arrow heads, and is remembered on a per-drawing basis. 

The "Current Wgt" option in the Text/Arrows/Smart Arrows/Weight menu will draw the 
arrow heads using the current line weight.  Using this setting saves you the step of defining 
a line weight for arrow heads, and is remembered on a per-drawing basis. 

Smart Arrow styles "Closed" and "Dot" support the KnockOut setting.  When enabled, they 
will obscure any other information which occupies the same coordinates in the drawing 
area. 

“Smart Arrow" has been added to the list of entities supported by selection mask.  When 
selecting entities, choose “Mask,” pick “Entity” and then toggle “Smart Arrow” on.  When 
you return to the selection menu, DataCAD will only select Smart Arrows. 

The "1st Ortho" toggle in the Smart Arrows menu has been enhanced.  When on, only the 
first segment of the Smart Arrow leader will be orthogonal, regardless of whether "Ortho 
Mode" is on or off in the "Tools" pull-down menu.  Previously, if Ortho Mode was checked 
all segments of the leader would be drawn orthogonal; in order to draw only the first 
segment orthogonal, you had to turn 1st Ortho on and turn Ortho Mode off. 

2D drafting and drawing 

The [Ctrl]+[Right-click] context menu has been enhanced to display new options when 
executed while the cursor is positioned over a blank space in the drawing area.   

 Selecting "Paste" will paste the contents of the Windows Clipboard.   

 Selecting "Paste Special" will open the "Paste Special" dialog enabling you to select from 
the available formats (if applicable) to paste the contents of the Clipboard.   

 Selecting "Paste As Symbol" will enable you to paste the current contents of the 
Clipboard as a symbol in the drawing, provided the Clipboard contains DataCAD 
information.  

 Choosing "Clipboard Select" invokes the Clipboard Selection mode so that you can 
choose information to Copy to the Clipboard.   

 Selecting "Save all drawing symbols to a folder" enables you to save all symbols 
currently instanced in the drawing to a selected folder on your hard drive.  Note: 
DataCAD will not save nested-level symbols or symbols which are no longer instanced. 

 



A temporary boundary box is displayed when creating or resizing MText and PText entities.  
Even if the MText or PText entity has “Boundary” turned off, this temporary box is 
displayed when you are placing or resizing the entity to show the limits of the object.  This 
boundary is temporary, and disappears as soon as you complete the process of defining the 
word wrap edge.  It will not display or print.  There is a corresponding dcadwin.ini key that 
can disable this feature.  See item 1 in the “New dcadwin.ini keys” section for details. 

Smart walls that are drawn on different layers support the ability to have their intersections 
cleaned using the "T Intersect," "L Intersect," and "X Intersect" commands in the Cleanup 
menu.  Layer Search must be toggled on for these to work.  Previously, only Smart walls that 
were drawn on the same layer could have their intersections cleaned. 

Added "Relocate" to the [Ctrl]+[Right-click] context menu for associative dimensions.  
Selecting this option puts DataCAD into dimension placement mode, so that you may 
reposition the dimension line using the existing dimension points. 

The "Bisect" function in the Geometry/Tangents menu supports the ability to select Smart 
walls.  Previously, only 2D lines were supported.  After selecting “Bisect” from the 
“Tangents” menu, choose two Smart walls.  DataCAD will rotate your cursor to match the 
angle of a line that would bisect the angle between the two walls. 

The "Justify" command in the "Text" menu supports the ability to select 2D Lines, 3D Lines 
and Smart walls as the line of justification, using the "Entity" option in that menu.  After 
selecting a justification line, and then exiting and returning to the menu, a "Prev. Line" 
option is now available, enabling you to use the previously selected justification line. 

The "1-Line Trim" command in the "Cleanup" menu supports the ability to select individual 
wall lines of Smart walls when defining the “Trim To” line.  Previously, this function was 
limited to selecting the control line. 

A "Prev. Line" option has been added to the Cleanup/1 Line Trim menu.  It enables you to 
choose a previously selected line as the trim-to line for the command.  After choosing "Prev. 
Line," you then pick the outside of the line, and then proceed with choosing lines to trim. 

An "Entity" toggle has been added to the "Mirror" menu which enables you to select a 2D 
Line, 3D Line or Smart wall to act as the line of reflection.  The status of this setting is 
remembered on a per-drawing basis. 

DataCAD supports the ability to select Circles in the "Line To Poly" function of the 
Polyline/Edit menu. 

Area, Perimeter and Volume have been added to the list of information returned on the 
Coordinates/Hints toolbar when you "Identify" a bitmap. 

The new toggle named "WYSIWYG" has been added to the Plotter menu.  This toggle is only 
available when "Pen Sort" is off.  When enabled, print order is exactly the same as screen 
display order, resulting in "What You See Is What You Get." 

Added a "3-Sided Only" option to the 3D Explode/To Polygons command.  When activated, 
exploding an object will result in a collection of 3-sided polygons.  This can be useful when 
exporting a model to a rendering application. 



The Layer Manager has new layer status indicators.  If the layer name is drawn in black text, 
the layer is turned on.  If the layer name is underlined, it is the current active layer.  If the 
layer name is gray, the layer is turned off.  If the layer name is red with a strikethrough, the 
layer is on and locked.  If the layer name is gray with strikethrough, the layer is off and 
locked. 

 

When you pick "Import" (and then either Replace or Merge) in the "Layers" menu to import 
a layer, the "Load from which file" dialog appears.  The default name in the "File name" field 
is the same name as the layer which is currently active in the drawing, and was previously 
limited to eight characters.  This limitation has been lifted, and the function now supports 
long layer names. 

New dcadwin.ini keys 

1) Added a key to dcadwin.ini to facilitate turning off the temporary boundary box that 
appears around MText and PText when placing or resizing the entity. 

[General] 
Show PText/MText Boundary On Entry/Resize=FALSE 

When TRUE (or absent), a temporary boundary box is displayed around MText and PText entities 
when creating or resizing them.  When FALSE, the temporary boundary box is not shown. 

 

2) Added a key to dcadwin.ini which disables the Lock Size feature on text and 
dimensions. 



[General] 
No LockSize=TRUE 

When FALSE (or absent), Lock Size is available in the Text and Dimension/Text Style menus (with 
Text Scale enabled).  When TRUE, the Lock Size button is no longer present in the Text or 
Dimension/Text Style menus.  If a drawing contains text that has Lock Size turned on, DataCAD will 
continue to change the size of the text in the drawing area when you change the plot scale.  Use 
the Change/More/Lock Size/Off menu command, or the "Lock Size" setting in the Entity Properties 
Editor, to turn Lock Size off if you wish to change this property for existing entities. 

 

3) Add the following key to the [General] section of dcadwin.ini to disable all hard-
coded keyboard interrupts (single-letter key presses): 

[General] 
Shortcut Keys Invoke Alias=TRUE 

When FALSE (or absent), single-letter keyboard interrupts continue to function as they always 
have.  For example, pressing [a] sends DataCAD to the "Architect" menu. 
When TRUE, DataCAD directly accesses the Command Line Alias function and executes the 
selected command.  This mode of command entry more closely mimics that of AutoCAD, and 
enables you to customize the keyboard commands.  For example, you could set the [a] key to take 
you to the "Arrow" menu instead of the "Architect" menu.  Multi-character aliases are also 
supported, for example "ZE" for "Zoom/Extents." 

For more information on creating a command line alias, see "Using the Command Line 
Alias" in Chapter 2 of the "DataCAD 14 Reference Manual." 

4) Add the following key to the [General] section of dcadwin.ini to disable direct 
distance input: 

[General] 
Spacebar For Distance Input=TRUE 

When FALSE (or absent), the [Spacebar] is not necessary to invoke coordinate input mode. 

New extended character codes 

The following extended character codes have been added: 

1066# : Pen Sort On 

1067# : Pen Sort Off 

1068# : WYSIWYG On 

1069# : WYSIWYG Off 

1079# : Hatch On 

1080# : Hatch Off  

1081# : Fill On     

1082# : Fill Off   

1083# : Bitmaps On   

1084# : Bitmaps Off   

 


